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Introduction
l Welcome
l “System Requirements ” on page 5
l “Links to Online Resources” on page 37

Welcome
Congratulations on your purchase of GibbsCAM, the most productive CAM system available.
This guide contains all the information you need to install the system and begin using the
software. If you have any problems with the installation procedure, contact your reseller; they will
be happy to assist you with the installation process.
Your order contains a Product Code. In the registration process, the Product Code and other
information are supplied to obtain a license file. Licensing is secured by hardware key or
Network License Option (NLO). All steps in this process are thoroughly explained in
“Registration” on page 14.
If you want to migrate settings and preferences from a installation of GibbsCAM, run the
Migration Tool before running the newly installed release for the first time. For complete
information, see “Migrating from Previous Releases” on page 32.

Important Information About Security
GibbsCAM security is provided by a license file that is linked to unique information from your
computing environment, such as the serial number of a hardware key or a unique identifier over
a network. The license file authorizes use of GibbsCAM products only when the hardware key is
present and recognized by the corresponding driver, or when the license server is running and it
validates the unique identifier.
GibbsCAM security is normally activated through the Internet. If you do not have Internet access
available, you can activate security using e-mail or regular mail. Please allow adequate time to
have the license file sent to you.
Please contact your reseller for support.

System Requirements
The requirements to run GibbsCAM do not have specific values. The requirements vary
depending upon the operating system you use and the complexity of your part. Basic guidelines,
listed below, are common to all users.

Operating
System

Windows 10, Windows 11, or Windows Server 2022. Please install the latest
available OS service packs and patches through Windows Update.

Microsoft This release requires Microsoft .NET Framework. Most machines will already
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.NET
Framework

have this (for example, if Office is installed), but if it is lacking, then the
GibbsCAMinstaller will tell you what is needed.

Hardware Minimum system requirements depend on the operating system. There are
also recommended hardware requirements. Please remember that the more
complex a part, the higher your system requirements. At least 8 GB of free
disk space is required to install the software. For more information, see
“Recommended System” on page 6.

Video
Drivers

Please install the latest available driver for your video card. The standard
Windows drivers are typically not adequate, because of the GibbsCAM
application’s advanced use of OpenGL and video RAM. We strongly
recommend that you keep your system up-to-date with fully installed and
updated drivers.

Network
Licensing

The Network Licensing Option (NLO) can be set up on 64-bit versions of any
of the following platforms: Windows Server (2016, 2019, or 2022);
Windows 7, 8, 10, or 11.
The current version of GibbsCAM uses Reprise License Manager (RLM),
unlike GibbsCAM versions 2023, 2022, 14, and 13, which used Cimatron
License Manager (CimLM).

Recommended System
A computer that matches or exceeds the following requirements will run GibbsCAM very
comfortably. Please note that the larger or more complex your parts are, the more
GibbsCAM will demand from your system.

Operating System Windows 11, or Windows Server 2022

CPU Intel: Core i9, i7, or i5 with four or more cores.
AMD: Ryzen or Threadripper

RAM 16 GB RAM

Video Card An Nvidia video card with 4+ GB of video memory.

Websites for GibbsCAM
• The Gibbs website — http://www.GibbsCAM.com — This website contains company news,

product information, and much more.
• The Gibbs Online page, https://online.gibbscam.com— This provides access to software

releases and release notes, updates to user guides, continuously updated documentation of
GibbsCAMmacros, and many other services and tools.

#URL_www.GibbsCAM.com
#URL_online.GibbsCAM.com
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Installation
l “Before Installing” on page 7
l “About the Installer” on page 8
l “File Locations ” on page 8
l “Installing the System Files ” on page 10

Before Installing
Before you install the software, ensure that you meet the system requirements and that you have
installed the most recent service pack for your operating system and the latest drivers for your
video card.

If a Version of GibbsCAM Is Already Installed
If you already have a version of GibbsCAM installed on your system:
• You should not uninstall the previous software.
• If you want to install multiple instances of the same version of GibbsCAM, see “Running

Multiple Instances of the Product ” on page 11.
• Be aware that the installer associates all .vnc files with the newly installed version of

GibbsCAM. If you want to open an existing part in an older version of GibbsCAM, simply drag
the file to a shortcut or to the program window, or use the Open dialog.

• Also be aware that if an older file is opened and saved in a newer version of GibbsCAM, it
can no longer be used in an older version. If necessary, you can work around this by using
File > Save a Copy to save the part as an older version.

• Before starting a newly installed version of GibbsCAM, users may want to run the Migration
Tool to migrate their settings and preferences from a previous release. The installation
process ends with a link to Migration Tool.

Before Installing Network Licensing Option (NLO)
For complete information on GibbsCAM Network Licensing Option, see “Network Licensing ” on
page 26.

Before Installing With a Hardware Key
If you have a hardware key, attach it before running the installer.
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Before Installing Across a Network

When installing GibbsCAM across a network to a system that has never had a version of
GibbsCAM or the hardware key drivers, we recommend that you install the drivers first, to avoid
encountering errors. If you encounter this error, simply click OK and continue the installation
process; then, after the process ends, install the hardware key drivers.

About the Installer
The installer lets you do any of the following:
• Repair or uninstall an existing installation of GibbsCAM 2026.
• Install the GibbsCAM 2026 base components and, optionally, one or more add-ins:

◦ GibbsCAM add-ins include ProAXYZ Posting support.
◦ CAD Transfer add-ins include Autodesk Inventor, Solid Edge, SOLIDWORKS, and many

others.
When the base components are installed, the GibbsCAM PDFs and the Moorpark engraving font
are automatically installed, and a desktop shortcut to the GibbsCAM 2026 application is created.

File Locations
The GibbsCAM installer writes files to three different locations, because different kinds of data
are accessed for different purposes:

l User data changes with each user.
l Global data applies to all users.
l Install data includes generic data and unmodified Reporter templates.

The installer is the only program that writes install data. The installer and the GibbsCAM
application write global data and install data. However, if the installer is re-run, it will not affect
user data and global data files that have been changed by the application.
Folders containing the three types of data are detailed below. If you customize these files or
upgrade your version of GibbsCAM frequently, then accessing and copying these files can
become quite important. The GibbsCAMMigration Tool is the preferred method for migrating
settings and preferences from previous GibbsCAM releases.
The following table shows the folder hierarchy.

User data C:\Users\<username>\AppData\Roaming\Gibbs\GibbsCAM\<version>

Global data C:\ProgramData\Gibbs\GibbsCAM\<version>

Install data C:\Program Files*\Gibbs\GibbsCAM\<version>

User Data Files

User Data includes such files as: sysdef.rsc (entries in dialogs), UIState.dat (location and
sizes of windows), and a Plugins\ folder (data entered in plug-ins). Even users with limited
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privileges can migrate User Data from a previous release using Migration Tool.

Global Data (Program Data) Files

Global data, also called program data, includes the bolt and tap tables, the CutDATA file
(Material.txt), your communication setup data (protocol.txt), a file that stores the Hole
Wizard data (prefs.rsc), a folder that contains your custom MDDs, the PostHASTE Library
folder that contains PostHASTE library files, and Reporter templates that have been modified or
customized.
The program data folder is the location where all customizable VMMs, MDDs, macros, and plug-
ins should reside. Although the installation folder contains read-only template versions of these
files — in other words, the original versions as shipped, before any customization — the intent is
for each seat of GibbsCAM to have its own potentially customizable version of these files
residing under the program data folder. Only users with Administrator privileges can migrate
program data files from a previous release using Migration Tool.
The location of the CutDATA file can also customized within GibbsCAM: On the Filemenu, click
Preferences and see the Files tab.

Installation Data Files

Installation files are read-only. They include generic versions of Global and User data files, the
default user-interface (*.cui) files, and the Reporter templates. Generic Reporter templates are
located in the...\PlugIns\Data\Report\ folder.
Only users with Administrator privileges can migrate installation files from a previous release
using the Migration Tool, and not all installation files can be migrated.

Reporter File Locations

Excel (*.xlsx) and text (*.txt) files can reside in up to three different locations:
• User data folder. The default location of this folder is:

C:\Users\<username>\AppData\Roaming\Gibbs\GibbsCAM\<version>\PlugIns\Data\Report\.
If a particular user has Reporter files here, they take precedence over other Reporter files.

• Global data folder. The default location of this folder is:
C:\ProgramData\Gibbs\GibbsCAM\<version>\PlugIns\Data\Report\.
If the Global data folder contains Reporter files, they will take precedence over Reporter files in the
Installation data folder but will be overriden by Reporter files in the User data folder, if any.

• Installation data folder. The default location of this folder is:
C:\Program Files*\Gibbs\GibbsCAM\<version>\PlugIns\Data\Report\.
Reporter files here are always present and cannot be deleted.

Imagine Company A, which prefers a custom Tool Summary report over the default
GibbsCAM-supplied summary. Company A places the files TlSum.txt and TlSum.xlsxin the
Global data folder (default C:\ProgramData\...). At company A, this is the version that most
users will receive when they use the GibbsCAM Tool Summary command or they pick Tool
Summary from the Reporter dialog. The Migration Tool will migrate this report from version to
version.
Now imagine a user named Lee, who works for Company A. Lee has made additional changes
to the Tool Summary Report, and saves these custom versions of TlSum.txtand TlSum.xlsx in
the User data folder (default C:\Users\Lee\AppData\...). Whenever Lee uses the Tool
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Summary command or picks Tool Summary from the Reporter dialog, the result will use these
additional changes. The Migration Tool will migrate this report from version to version.

Existing Communications, CutDATA and Library Files

Installing a new version of GibbsCAM creates a default material database, a blank
communications file, default PostHASTE library files, and default Reporter templates. Once the
new version is installed, you can copy protocol.txt, material.txt and the Library\ folder
to the new GibbsCAM folder.

User Access To AppData Folders

Windows marks user AppData\ folders as invisible; limited users cannot see them. If you do not
use Migration Tool, you may need an administrator’s assistance to find and modify these folders.

Installing the System Files
Before you install the software, be sure to review “Before Installing” on page 7.
If you will be using the Network Licensing Option (NLO):
• The GibbsCAM application software must be installed on each client machine, using either

the interactive installation wizard or the installer run in "silent" mode. The application
software must be installed before the license files generated by GibbsCAM are installed.

If you are upgrading from a previous release, consider running the GibbsCAMMigration Tool
after you install but before your first launch of the newly installed software. For more information,
see “Migrating from Previous Releases” on page 32.

Step-By-Step Instructions
The following instructions assume you want to use the fully interactive installation wizard. If,
instead, you prefer to install non-interactively without the wizard, see “Silent Installation Mode ”
on page 11.
For more information on Migration Tool, see “Migrating from Previous Releases” on page 32.
If you are setting up a Network License installation, click Cancel and refer to “Network Licensing ”
on page 26.
To Install the System Files
1. Navigate to the Gibbs Online page, https://online.gibbscam.com.
2. Navigate to the Software Downloads page.
3. Select and download the appropriate language for the machine operator.
4. Once download is complete, open the executable file.
5. Follow the onscreen prompts.
To Launch the Application
To launch the GibbsCAM application, do one of the following:

◦ In Start > Programs, select the GibbsCAM item.
◦ Double-click the desktop shortcut to the GibbsCAM executable.
◦ Double-click a *.vnc file.

The first time you launch GibbsCAM, the following dialog appears:

#URL_online.GibbsCAM.com
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If you are installing GibbsCAM for the first time, you must register the software. For more
detailed information on registering the software, see “Registering GibbsCAM” on page 14.

Running Multiple Instances of the Product
GibbsCAM 2026 natively supports simultaneously running multiple instances of the application —
either different versions or different instances of the same version. If you want to install multiple
instances of the same versionGibbsCAM version, such as differently localized instances, make a
copy of the existing instance in a different folder (such as
C:\Program Files\*\GibbsBackup\, where "*" might be "Gibbs" or "Gibbs"), and then re-run
the installer. First uninstall the previous instance, and then install the new one.
There is no problem running multiple versions of GibbsCAM at the same time. However, an
earlier version might be unable to open parts saved in a later version. You can use the File > Save
As Copy option to save the part as if it were a previous version. (But: See the Readme file about
saving TMS files to versions before GibbsCAM 12.)
Reminder: For best results migrating settings and preferences from a previous release, each
user should run the Migration Tool before starting a newly installed version of GibbsCAM. For
more information, see “Migrating from Previous Releases” on page 32.

Silent Installation Mode
The process for installing in the background changed at GibbsCAM 12 to use InstallShield.
Previously called “unattended” or “quiet” installation, it is now called "silent" installation.

Accepting All Defaults
The simplest and easiest way to use silent installation mode is to accept all defaults. To do this,
you use the /sflag with no other flags or parameters, in this form:
<installername>.exe /s
For example, to silently install GibbsCAM 26.0.27.10 in English with all defaults:
GibbsCAM_x64_v26.0.27.10_en-US.exe /s
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Uninstalling
To uninstall silently, use the /x /s flags, in this form:
<installername>.exe /x /s
For example, to silently uninstall Japanese-language GibbsCAM 26.0.29.2:
GibbsCAM_x64_v26.0.29.2_ja-JP.exe /x /s

Customizing a Silent Installation: Using an *.ISS File

You can also customize which options you install, which locations you install to, to not run
Migration Tool, or other nondefault choices. To do this, you use an *.ISS file that contains the
customizations, in conjunction with the GibbsCAM installer *.exe file. Note that when you
perform a silent installation, the version of the installer executable must match the version of the
installer executable that was used to record the *.ISS file.
• To create an *.ISS:

Run the interactive GibbsCAM installer with the /r flag to record an *.ISS file. The file
specified in the /f1"<filename>.ISS" flag captures all parameters and paths supplied in
this interactive installation. For details, see below.

• To install silently using an *ISS:
Run the GibbsCAM installer with the /s flag and the /f1"<filename>.ISS" flag. This
silently installs GibbsCAM using parameters in the *.ISS file. For details, see below.

A. To create an ISS file

1. Run the installer with flags /rand /f1 (and, optionally, /f2).
2. Supply information to the interactive installer.
3. When you click Finish, the *.ISS file is fully recorded and can be used for future silent

installations.
Step 1 has the following form:
<installername>.exe /r/f1"<path>\<ISSfilename>"
• Example A1

To use the GibbsCAM 26.0.36.8 English-language installer to generate an ISS file named
Auto26368.ISS located in folder D:\temp\, you would open a command prompt, change
directories to the installer location, and enter the following command:
GibbsCAM_x64_v26.0.36.8_en-US.exe /r /f1"D:\temp\Auto26368.ISS"

• Example A2
To use the GibbsCAM 26.0.30.0 French-language installer to generate an ISS file named
MonGC26.ISS located in folder H:\Gibbs\, you would enter the following command:
GibbsCAM_x64_v26.0.30.0_fr-FR.exe /r /f1"H:\Gibbs\MonGC26.ISS"

B. To silently install GibbsCAM using an ISS file

1. Run the installer with flags /sand /f1 (and, optionally, /f2).
2. If necessary, authorize the UAC (user account control) to install to the location specified in

the *.ISS file.
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Step 1 has the following form:
<installername>.exe /s/f1"<path>\<ISSfilename>"
• Example B1

To use the GibbsCAM 26.0.28.2 Latin-American Spanish-language installer to silently install
using the parameters in an ISS file named myGC.ISS located in the same folder as the
installer, you would open a command prompt, change directories to the installer location, and
enter the following command:
GibbsCAM_x64_v26.0.28.2_es-MX.exe /s /f1"myGC.ISS"

• Example B2
To use the GibbsCAM 26.0.29.10 English-language installer to silently install using the
parameters in an ISS file named GC_SilentInstall.ISS located in folder F:\GibbsData\,
you would open a command prompt, change directories to the installer location, and enter
the following command:
GibbsCAM_x64_v26.0.29.10_en-US.exe /s /f1"F:\GibbsData\GC_
SilentInstall.ISS"

C. If you want to write out a log file

If you want to log results of either the recorded (/r) installation or the silent (/s) installation, you
can use an optional third flag, /f2"<path>\<logfilename>".
For example:

◦ GibbsCAM_x64_v26.0.26.8_en-US.exe /r /f1"D:\temp\Auto26268.ISS"
/f2"D:\temp\Log26268.txt"

◦ GibbsCAM_x64_v26.0.29.10_en-US.exe /s /f1"F:\GC_SilentInstall.ISS"
/f2"tempLogFile.txt"
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Registration
• Registering GibbsCAM
• “Registration Tools” on page 20
• “License Updates” on page 21

Registering GibbsCAM
When a fresh installation of GibbsCAM is first started, it reports that no license file is found. After
registration is complete, however, GibbsCAM will continue on to run as usual.

The License Installation or License Update dialog lets you drag an RLM license file (*.lic) onto the
dialog for application installation, browse the computer for a license file (*.lic), or run the
Registration Tool to obtain a license file (*.lic) through the Gibbs Activation Service.
Note that this release uses Reprise License Manager (RLM), not Cimatron License Server
(CimLM). If you try to use a CimLM *.cml file instead of an RLM *.lic file, it will not work.

Reseller Activation - If your Reseller will be assisting you with your installation,
have your registration files (and hardware keys, if any) ready in advance.

Running the Registration Tool
1. Click the Run Registration Tool... link.
2. Enter your Product Code from your order materials and click Next.
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3. Enter your customer information and click Next.

4. Complete your registration using one of the following methods. If you do not have an e-mail
account, enter the e-mail address of your reseller.

Registration Type Purpose

Internet Registration Register online. This is the quickest, easiest way.

E-Mail Registration If you are in a secured network environment.

Offline Registration If you have no Internet access.
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Internet Registration

If the Registration Tool determines that the computer can directly contact the Gibbs Activation
Service, the final page of the Registration Tool lets you click Finish to automatically obtain a
license file.

E-Mail Registration

If the Registration Tool determines that the computer cannot directly contact the Gibbs Activation
Service but has access to e-mail, the final page of the Registration Tool lets you click Finish to
send the license registration data to Gibbs as an e-mail attachment.
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Clicking the Finish button will bring up an e-mail form page using your default e-mail program.

Follow the e-mail program's directions to send the license registration data. GibbsCAM will
process your license registration as quickly as possible. When you receive it, see Completing E-
Mail or Offline Registration.

Offline Registration

If the Registration tool determines that the computer cannot directly contact the Gibbs Activation
Service and lacks access to e-mail, then the Registration Tool will prompt you to click Finish to
save license registration data to a file:
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When you click Finish, the Save As dialog prompts you to save your license registration data to a
file:

After you save your registration data file, you can send it to GibbsCAM in several ways:

A computer
with e-mail
access

E-mail the file to Registration@GibbsCAM.com.

Your
Reseller

Your Reseller may be able to assist you in your activation. If your Reseller can
assist you, have your registration files and (and hardware keys, if any) ready
in advance.

Completing E-Mail or Offline Registration

5. After you receive your license file from GibbsCAM, save it on your computer and launch
GibbsCAM. On first startup, the following dialog appears:

mailto:Registration@gibbscam.com
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6. You can either drag and drop the license file onto that dialog or click the Browse for your license
file on this computer… link, which opens a dialog that lets you navigate to the file and select it:

7. After you locate and open the license file, you should see a message dialog resembling the
following:
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8. When you click OK, GibbsCAM starts; your installation of GibbsCAM 2026 has been
authenticated.

Registration Tools
Two registration utilities are provided:
• RegistrationTool.exe — See Standalone Licensing Utility
• ActivationCheck.exe — See “Verifying Activation Server Connectivity ” on page 21

Standalone Licensing Utility
The Registration Process can also be activated without running GibbsCAM. Look for
Registration Tool in the GibbsCAM\ folder in the Windows Start menu. You can also access
the standalone registration from the GibbsCAM installation folder. You can do this easily by
searching for RegistrationTool.exe.

The Licensing Utility allows you to send license registration data and obtain and manage
licenses for several different types of GibbsCAM installations:
• The Hardware Locked type is equivalent to the license installation from running GibbsCAM

from a non-NLO GibbsCAM installation.
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• The Network License Client type is equivalent to the license installation from running
GibbsCAM from an NLO GibbsCAM installation.

• The Network License Server type installs the NLO server and license to a folder you specify.
• The Hardware Locked (offline) type installs a non-NLO client license to a folder you specify.

This may be useful when pre-generating licenses for computers that may not have Internet
access and can only be used with removable hardware key licenses. To generate an offline
license, follow these steps:
a. Specify a deployment destination for the offline license in Licensing Utility.
b. Attach the hardware key that you intend to use on the offline computer.
c. Click the Run Registration Tool... link and generate the offline license file following

instructions in “Running the Registration Tool” on page 14. This action generates a
license file in the specified folder.

d. Move the generated license-x.xxx.clm file to the offline computer.
e. Start GibbsCAM.
f. Drag and drop the license file onto the GibbsCAMLicense Installation dialog (or use the

Browse for your license file on this computer... link).

Verifying Activation Server Connectivity
ActivationCheck.exe is a simple utility that checks for connectivity with the Gibbs Activation
Service. You can find this application in the Bin\ folder of your GibbsCAMinstallation folder or by
using the Start button's Search feature.

License Updates
If you need to update or change your license file to add options to your license, you can connect
to the Gibbs Activation Service from the File > Preferences dialog, Interface tab.
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Click the License Update button to open the Update Registration dialog.
To update your Product key and license, follow the steps for “Running the Registration Tool” on
page 14.
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GibbsCAM Viewer
GibbsCAM Viewer lets you directly access all part information without allowing toolpath
generation, posting, or saving/exporting, etc. Viewer and Industrial share the same installer
(product level is determined by license) and user interface: Existing GibbsCAM users can use
Viewer with no learning curve or training.

Initial startup screen of GibbsCAM Viewer

Installation, Registration, and Licensing
GibbsCAM Viewer and GibbsCAM Industrial Edition use the same installer, installation steps,
and registration tool. For details, see “Installing the System Files ” on page 10 and “Running the
Registration Tool” on page 14.

The system differentiates Viewer from Industrial through the license file. This file is generated
when you enter your product code into the Registration Tool and register the software. The
license file resides under the global data folder, in this location:
C:\ProgramData\Gibbs\GibbsCAM\<version>\LicenseData\<release>\.
For example, the license file for GibbsCAM 2026 resides here:
C:\ProgramData\Gibbs\GibbsCAM\<version>\LicenseData\260.0\license-******-#.lic.

Running Viewer and Industrial
Because the system looks for only one *.lic file at a time, you normally run either GibbsCAM
Industrial Editionor GibbsCAM Viewer on a single machine, not both. But this limitation can be
overcome by using NLO (Network License Option) or a Dealer license.
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PowerOpts.txt and Preferences > License Options
If you have a Dealer license, or if you have set up NLO to serve licenses for both Industrial and
Viewer, you can use the following two procedures to run both products on the same machine.

To set up: In PowerOpts.txt, uncomment "Option_Limiter"
1. With Administrator privileges, open the installation folder. This folder is usually

C:\Program Files*\Gibbs\GibbsCAM\<version>.
2. Make a backup copy of the original PowerOpts.txt file.
3. Edit PowerOpts.txt and find this line:

// Option_Limiter
4. Delete the line's first three characters, leaving:

Option_Limiter
5. Save your changes.

Result: The next time this machine starts this release of GibbsCAM, the Product Options dialog
opens, allowing you to choose all or a subset of available product options.

To choose product options: File > Preferences > Interface >
License Options
1. Within GibbsCAM, open the Preferences dialog and access its Interface tab.
2. Click the License Options button.

Result: The License Manager dialog opens. The pulldown menu at its top allows you choose
between GibbsCAM Viewer and GibbsCAM, as illustrated below.

Switching between GibbsCAM Viewer and GibbsCAM
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Viewer Capabilities
Users of GibbsCAM Viewer can do all the following.

l Open parts (*.vnc) and packages (*.gcpkg)
l Rendering, including:

l Toolpath (including color modes)
l Wireframe geometry; and solids, surfaces, and facet bodies
l CS grid, stock, and origin
l Dimensioning and PMI
l Show Clearance Planes/Volumes
l Section View
l All Simulation modes

l All View and Viewport controls
l Measurement: Dimension creation (other than Text), View >Measure, etc.
l Solid and part query tools and plug-ins: Show Taper Angle/Curvature, Get Draft Angle, Show Surface
Normals, Solid Inquiry, Show Position, Find Ops, etc.

l Reporter output
l Op, Tool, and Process tile lists (including tile list view modes)
l Op Manager, Tool Manager, and Process Manager (without Edit capabilities)
l Op Data dialog
l Op To Geometry (to permit dimensioning)
l Utility markers (but not marker placement)
l Tool and Process dialogs (but with Do It and Redo unavailable)
l Activate Ops / Deactivate Ops
l Feature Manager, Attribute Manager, and Hole Manager (with restrictions)
l CS List / WG List (with restrictions)
l Program Error Checker; Body Bag; Printing; Update Notification
l Help: PDFs, Online Help, Balloons, Check for Updates, and Copilot

Workspace of GibbsCAM Viewer and some of its capabilities
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Network Licensing
The current version of GibbsCAM uses Reprise License Manager (RLM), unlike
GibbsCAM versions 2023, 2022, 14, and 13, which used Cimatron License Manager (CimLM).
This affects all customers using GibbsCAM NLO.

What Remains the Same As 2023 and Before

As in GibbsCAM 2023 and before, Network Licensing (NLO) establishes a network license
server that maintains a software key for each GibbsCAMproduct option purchased from
GibbsCAM. These software keys (or “licenses”) are distributed to nodes across a network to
enable the workstations (nodes with installed GibbsCAM application software) to run the
purchased module options. NLO is an alternative to hardware keys: When a client runs the
GibbsCAM application software, a software key is “checked out” from the license server. There
is no limit to the number of GibbsCAM seats installed on the network, only a limit to the number
that can be used concurrently with each license server. Each client’s license file can be created
and installed through the Internet or, if the workstation lacks Internet access, by electronic or
physical mail.

If You Use Cimatron Products

If you use Cimatron products as well as GibbsCAM products, you can continue to use the
Cimatron license-server machine to serve Cimatron licenses. For GibbsCAM products, either
you can install the RLM software on this machine (the two can coexist without conflicting), or you
can install the RLM software on a different license-server machine.
Note (unrelated to NLO): Cimatron hardware keys cannot serve GibbsCAM licenses. If you use
both hardware keys for both Cimatron and GibbsCAM products, you must use separate sets of
hardware keys. This is a very rare case; most customers who use NLO do not use hardware
keys.

What Changed

The first time you install this release of GibbsCAM NLO, you will use an initial one-
time administrator password. You must change this password within ten minutes
or else the service will terminate.

NLO License borrowing with checkout/return/expiry parameters
Users can now check out an NLO license for a specified time period, then disconnect from the
network. This allows users to borrow licenses, disconnect, move their laptop, and keep using the
GibbsCAM products even when the license server is stopped. Borrowed licenses can be
returned manually, or they can be set to expire after a set time.
Where users can find this option: Under File > Preferences > Interface, click License Options; then,
in the License Manager dialog, click Start Roaming.
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How administrators can support this option: Reprise License Server Administration shows the
count of roaming licenses in its License Pool Status:
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Operating Systems Supporting RLM

Reprise License Manager requires Windows Server 2008 R2 or Windows 7 ("NT 6.1") or later.
Although this includes desktop platforms like Windows 8 ("NT 6.2"), Windows 8.1 ("NT 6.3"),
Windows 10, and Windows 11, we recommendWindows Server: 2008 R2, 2012, 2012 R2,
2016, or (best) 2019 if more than five users will be simultaneously connected to the license
server.

Overview of Network License Installation
Installation of the Network License Option (NLO) is a two-phase process: In Phase 1, you set up
the Reprise License server. In Phase 2, you install and register the client software on each node.
For condensed steps, see below; for details, see “NLO Step 1 - Setting Up The Server ” on
page 29.

Condensed Steps: To Set Up the License Server

1. With Administrator privileges, on the machine that will be serving GibbsCAM licenses, run
the installer setup file:
GibbsCAMNLOServer-24.<x>.<y>.<z>.exe
to install the License Server software, Registration Tool, and support files.
This installer setup file can be downloaded from Gibbs Online (online.gibbscam.com) and
elsewhere.

2. On the server machine, open this URL
http://localhost:5054/
using the following initial one-time credentials:
username .... admin
password .... admin
Important:You must change this password within ten minutes or else the service will
terminate.

3. From the folder where you installed the License Server software (default
C:\Program Files\GibbsCAM\GibbsCAM NLO Server 2026\),
run RegistrationTool.exe

4. When the Licensing Utility window appears:
a. For License Registration Type, choose Network

License Server (the third choice).
b. For Deployment Destination, enter or browse to a

writable folder.
c. Either:

▪ Browse for an existing *.lic license file on
your computer.

Or, if you do not yet have a *.lic file:
▪ Click the Run Registration Tool link and

then, in the Server License Registration
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Tool window, enter (or copy-and-paste) your 20-character product license code.
For details, see “NLO Step 1 - Setting Up The Server ” on page 29.

Condensed Steps: To Install The Client Software 

1. Install the GibbsCAM application software on the client machine. For instructions on
installing the software, see “Installing the System Files ” on page 10.

2. Ensure that the License Server is running on the license server machine and that the client
can connect to it, and then register GibbsCAM on the client machine.

For details, see “NLO Step 2 - Install the Client Software On Each Node” on page 30.

NLO Step 1 - Setting Up The Server

The first time you install this release of GibbsCAM NLO, you will use an initial one-
time administrator password. You must change this password within ten minutes
or else the service will terminate.

Before you begin: On the machine where you will install the License Server, you must have
administrator privileges. The installer setup file
GibbsCAMNLOServer-24.<x>.<y>.<z>.exe
must be available. This file can be downloaded from https://online.gibbscam.com(under
Software Downloads, click the Tools link), or it can be loaded from the product media in folder
\Content\NLO Registration\.
Before installing or modifying NLO Server, ensure that the firewall service is started (Services 
(Local) > Windows Firewall, Status = Started). Then, run the NLO installer. After the
installation/modification is complete, you can stop your firewall service if necessary.
1. With Administrator privileges, on the machine that will be serving GibbsCAM licenses, run

the executable to install the License Server software.
GibbsCAMNLOServer-24.<x>.<y>.<z>.exe
The steps are as follows:
(a) UAC: Yes
(b) Select the language you prefer
(c) For Welcome: Click Next
(d) Accept the License Agreement and click Next
(e) For Destination Folder: Browse to or accept a folder and click Next
(f) Click Install.

2. In a browser window on the server machine, open this URL
http://localhost:5054/
using the following initial one-time credentials:
username .... admin
password .... admin
Important:You must change this password within ten minutes or else the service will
terminate.
Note: After you install the server software, the service (GibbsRLMServer) might be set to
Manual startup. It is a good idea to set the service so that its Startup Typeis Automatic instead
ofManual.

#URL_online.GibbsCAM.com
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3. From the folder where you installed the License Server software (by default, this is
"C:\Program Files\GibbsCAM\GibbsCAM NLO Server 2026\), run
RegistrationTool.exe.
Note: If, when you launch Registration Tool, you receive an error message saying that
vcruntime140_1.dll is missing, do the following:

l Download and install the Microsoft Visual C++ Redistributable Package:
https://aka.ms/vs/17/release/vc_redist.x64.exe

l Ensure that all updates and patches to Microsoft Windows have been installed and
applied.

4. When the Licensing Utility window appears :
a. For License Registration Type, choose

Network License Server (the third
choice).

b. For Deployment Destination, enter or
browse to a writable folder.

c. Do one of the following:
▪ If you already have a *.lic

license file on your computer,
use the Browse link to find and
select it. The current version of
GibbsCAM uses Reprise
License Manager (RLM), unlike
GibbsCAM versions 2023,
2022, 14, and 13, which used
Cimatron License Manager
(CimLM). If you try to use a
CimLM *.cml file instead of an RLM *.lic file, it will not work.

▪ Or, if you do not already have a *.lic license file on your computer:
Click the Run Registration Tool link and then,
in the Server License Registration Tool
window, enter (or copy-and-paste) your 20-
character product license code.
When the activation is complete, a license file,
license-<customer_id>-<server_
number>.lic, is created in your deployment
directory.

NLO Step 2 - Install the Client Software On
Each Node
Before you begin: Make sure the license server machine is running the RLM License Server
software and that the client machine (workstation) has a network connection to it.

Note: If a client machine cannot connect to the server after registration, ensure that ports
2764 and 2765 are not blocked and, if necessary, adjust the HOST name in the licensefile:
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To adjust the HOST name in the licensefile, use Notepad to open the client's *.lic file and
make sure the HOST name is correct, using one of the following examples.
Example 1: If the license file references the server by hostname (such as "myServer"):
#LSHOST=myServer
HOST myServer
Example 2: If the license file references the server by IP address (such as "10.101.102.103"):

#LSHOST=10.101.102.103
HOST 10.101.102.103

Steps

1. On the client machine (workstation), install the GibbsCAM software, using the same product
code that was used for installing the server. For step-by step-instructions, see “Installing the
System Files ” on page 10.

2. Register GibbsCAM for this client workstation.
You can do this manually at any time by running the Registration Tool. Or, if you launch
GibbsCAM, it will display the License Installation dialog to prompt you for the product code.
Use the same product code that was used for the server. On NLO client machines, you are
not prompted for contact information.

3. After you enter the product code, click Activate Product to complete the license deployment.
The license data will be retrieved from the Gibbs Activation Service and placed in the
appropriate Activation Data folder.

4. Repeat the previous steps (installing the GibbsCAM software and registering the product
code) for each GibbsCAM client of the RLM license server machine.
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Maintenance and Special Topics
The following are miscellaneous topics that can be helpful in some circumstances after you have
installed GibbsCAM.
• Migrating from Previous Releases
• “Installing Post Packages” on page 34
• “Undoing All Customizations” on page 34
• “Using Command-Line Options” on page 34

Migrating from Previous Releases
The GibbsCAMMigration Tool lets you detect all previously installed versions of GibbsCAM and
copy compatible settings and preferences — UI and display settings, custom MDDs and VMMs,
HSM settings, bolt and tap table data, macro configuration file, machine models, and so forth —
from a specified previous version to the current release. The previous version is not modified.
For best results, run the Migration Tool before the first time you start a newly installed release of
GibbsCAM. This allows old files to be migrated before they are blocked by new files created in
the newly installed version.

Using the Migration Tool

You can launch the tool from the Startmenu: GibbsCAM >Migration Tool 2026.x.y.z. To run this tool
with Administrator privileges (recommended), navigate to its parent folder (default
C:\Program Files\Gibbs\...\Bin\), right-click the filename GibbsMigrationTool.exe,
and choose context menu option Run as administrator.
1. The first dialog lets you scan your system for installed versions of GibbsCAM, select one

from the list, and check it for compatibility.
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2. The second dialog shows you the files that can and cannot be copied forward to the current
release. Appropriate restrictions are respected if Administrator privileges are lacking.

Note: There is no ability to migrate plug-ins or material databases from previous releases.
However, settings for Plug-In Manager can be migrated.
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Installing Post Packages
When you receive a post processor package as a .zip file from the GibbsCAM Post department,
you can install it simply by dragging it onto a running instance of GibbsCAM or using File > Open.
This extracts the contents of the package and copies files to the appropriate locations under the
ProgramData\ folder:
• MDDs are extracted to the MDD\ subfolder of the global data folder — normally

C:\ProgramData\Gibbs\GibbsCAM\<version>\MDD\
• VMMs are extracted to the VMM\ subfolder of the global data folder — normally

C:\ProgramData\Gibbs\GibbsCAM\<version>\VMM\
• Post files are extracted to the Posts\ subfolder of the global data folder — normally

C:\ProgramData\Gibbs\GibbsCAM\<version>\Posts\
• Certain other special-purpose files (such as .txt files for GCode Files\ and macro files for

CustomDrillCycles\) are also extracted to the correct folders.
When a post package is installed in this way, if the target folder already contains .mdd or .vmm
files with identical names, the pre-existing versions are overwritten.

Undoing All Customizations
Sometimes circumstances arise when you want to restore the as-shipped “factory” settings. For
example, a particular user might want to remove all user-set preferences, such as customized
defaults for interface background or lighting, or customized plug-in settings. Or, more broadly, a
site might want to remove all site-customizable items, including the materials database, all
custom MDDs and VMMs, and so forth.
Use this method only if you want to undo all customizations. Before wiping out extensive
customizations, it is usually advisable to create a backup copy.
• To undo user customizations, simply delete/move/rename the user data folder:

C:\Users\<username>\AppData\Roaming\Gibbs\GibbsCAM\<version>.
Note: In releases prior to Version 11, the grandparent folder was named Gibbs\ rather than
Gibbs. For example, to suppress the customizations made by user “ChrisM” on GibbsCAM
version 10.0.97, you could move this folder:
C:\Users\ChrisM\AppData\Roaming\Gibbs\GibbsCAM\10.0.97\

• To undo site customizations, delete/move/rename the global program data folder:
C:\ProgramData\Gibbs\GibbsCAM\<version>.
For example, to undo the site customizations made to GibbsCAM version 12.9.99, you could
rename this folder:
C:\ProgramData\Gibbs\GibbsCAM\12.9.99\

Using Command-Line Options

Command-Line Option for License Checkouts
You can start GibbsCAM with the -lo command-line option to specify a license option file.
For example, this command line:
virtual.exe -lo MyLicenseOptions.txt
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will attempt to check out the licenses specified in the MyLicenseOptions.txt file and, if
successful, start GibbsCAM.
If any of the requested options cannot be checked out, then the user is notified, none of the
specified licenses are checked out, and GibbsCAM exits.
The *.txt file specified by the -lo option uses this syntax:
Lines beginning with #or // are comment lines; they have no effect on execution.
Lines beginning with a valid GC* keyword (see below) will check out the corresponding license
on startup.

License Options: GC* keywords
GCMGoMilling GCMGoSolidMilling GCMGoProMilling GCMGoTurning
GCMGoSolidTurning GCM5Axis GCM5AxisMultiblade GCM5AxisPorting GCMMTM
GCMTMS GCMProbing GCMPTCCreoSpatial GCMCATIASpatial GCMNXSpatial
GCMAPTCL GCMPostDeveloper GCMEDM GCMEDM_PartialPocketing GCMEDM_
4AxisPocketing GCMEDM_MachAC_Cut_2030 GCMEDM_MachAC_Cut_X00 GCMEDM_
MachAC_Cut_EXX0 GCMEDM_MachAccutex GCMEDM_MachExcetek GCMEDM_MachFanuc
GCMEDM_MachJoemars GCMEDM_MachMakino GCMEDM_MachMitsubishi GCMEDM_
MachSeibu GCMEDM_MachMSeibu GCMEDM_MachONA GCMEDM_MachSodick GCMEDM_
MachAC_Fanuc GCMEDM_MachAC_Millenium GCMEDM_MachAC_Orange GCMEDM_
MachAC_Vision GCMEDM_MachAC_Cut_Uniqua GCMEDM_MachAgie_100123 GCMEDM_
MachAC_Robofil GCMEDM_MachBrother GCMEDM_MachCHMER GCMEDM_MachHitachi
GCMEDM_MachJapax GCMEDM_MachGeneric
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Conventions
GibbsCAM documentation uses two special fonts to represent screen text and keystrokes or
mouse actions. Other conventions in text and graphics are used to allow quick skimming, to
suppress irrelevancy, or to indicate links.

Text

Screen text.  Text with this appearance indicates text that appears in GibbsCAM or on your monitor.
Typically this is a button or text for a dialog.
Keystroke/Mouse.  Text with this appearance indicates a keystroke or mouse action, such as
Ctrl+C or right-click.
Code.  Text with this appearance indicates computer code, such as lines in a macro or a block
of G-code.

Graphics

Some graphics are altered so as to de-emphasize irrelevant information. A “torn” edge signifies
an intentional omission. Portions of a graphic might be blurred or dimmed to highlight the item
being discussed. For example:

Annotations on a graphic are usually numbered callouts (as seen above), and sometimes
include green circles, arrows, or tie-lines to focus attention on a particular portion of the graphic.
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Links to Online Resources
Please contact your reseller for support.

Link URL Action / Description

Go http://www.GibbsCAM.com Opens the main website for GibbsCAM.

Go https://online.gibbscam.com
Opens Gibbs Online page to download
GibbsCAM and all supported material.

http://www.gibbscam.com/
https://online.gibbscam.com/

	Introduction
	Welcome
	Important Information About Security

	System Requirements
	Recommended System
	Websites for GibbsCAM


	Installation
	Before Installing
	If a Version of GibbsCAM Is Already Installed
	Before Installing Network Licensing Option (NLO)
	Before Installing With a Hardware Key
	Before Installing Across a Network


	About the Installer
	File Locations
	User Data Files
	Global Data (Program Data) Files
	Installation Data Files
	Reporter File Locations
	Existing Communications, CutDATA and Library Files
	User Access To AppData Folders

	Installing the System Files
	Step-By-Step Instructions
	Running Multiple Instances of the Product

	Silent Installation Mode
	Accepting All Defaults
	Uninstalling
	Customizing a Silent Installation: Using an *.ISS File
	A. To create an ISS file
	B. To silently install GibbsCAM using an ISS file
	C. If you want to write out a log file



	Registration
	Registering GibbsCAM
	Running the Registration Tool
	Internet Registration
	E-Mail Registration
	Offline Registration
	Completing E-Mail or Offline Registration


	Registration Tools
	Standalone Licensing Utility
	Verifying Activation Server Connectivity

	License Updates

	GibbsCAM Viewer
	Installation, Registration, and Licensing
	Running Viewer and Industrial
	PowerOpts.txt and Preferences > License Options
	To set up: In PowerOpts.txt, uncomment Option_Limiter
	To choose product options: File > Preferences > Interface > License Options


	Viewer Capabilities

	Network Licensing
	What Remains the Same As 2023 and Before
	If You Use Cimatron Products
	What Changed
	Operating Systems Supporting RLM
	Overview of Network License Installation
	Condensed Steps: To Set Up the License Server
	Condensed        Steps: To Install The Client Software

	NLO Step 1 - Setting Up The Server
	NLO Step 2 - Install the Client Software On Each Node

	Maintenance and Special Topics
	Migrating from Previous Releases
	Using the Migration Tool

	Installing Post Packages
	Undoing All Customizations
	Using Command-Line Options
	Command-Line Option for License Checkouts
	License Options: GC* keywords



	Conventions
	Text
	Graphics

	Links to Online Resources

